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Graphical Mode Examples
About the Examples

This guide includes descriptions of the following examples.

Category Example number

"Thermo-Calc Graphical Mode Examples Collection" on the next page includes
binary and ternary system examples, Scheil, the Equilibrium Calculator, plus more T_01 to T_09

"Thermo-Calc Property Model Examples Collection" on page 26: General and
Steel models

General models: PM_G_
01 to PM_G_03

Steel models: PM_Fe_01
to PM_Fe_03

"Process Metallurgy Examples Collection" on page 41 PMET_01 to PMET_02

"Diffusion Module (DICTRA) Graphical Mode Examples" on page 55

D_01, D_02, D_03 (the
Quick Start Guide
Examples)

D_04 to D_07

"Precipitation Module (TC-PRISMA) Graphical Mode Examples" on page 77 P_01 to P_13
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Thermo-Calc Graphical Mode Examples Collection

T_01: Calculating a Single-Point Equilibrium
This example shows the result from a single-point equilibrium calculation in the Fe-C system.
It demonstrates the use of the Equilibrium Calculator and generates a Table Renderer in the
Results window. The number of equilibrium conditions is C+2 where C is the number of
components, meaning that four conditions are needed in this example:

l Temperature is 1000 K

l Pressure is 101325 Pa

l System size is 1 mole

l Mass percent carbon is 0.1%

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_01_Single-point_equilibrium.tcu

This example is included as a tutorial on our website and our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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TABLE RESULT

The displayed results of the calculation show that the BCC_A2 (ferrite) and GRAPHITE phases
are stable for this set of equilibrium conditions.
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T_02: Stepping in Temperature in the Fe-C System
This example shows how the fractions of stable phases vary for an Fe-0.1 mass-% C alloy
when the temperature is varied between 500 and 2000 K. It demonstrates the use of the
Equilibrium Calculator. To allow temperature to vary, the corresponding Axis Definition
check box is selected.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_02_Step_in_temperature_in_Fe-C.tcu

This example is included in the tutorial on our website and YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/_BlSlWxeF_g
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PLOT RESULT

In this example, results are displayed graphically using a Plot Renderer activity.

If you want, you can use a Table Renderer to generate text results instead, as shown in this
example after adding a Table Renderer to the Equilibrium Calculator and clicking Perform.
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T_03: Fe-C Phase Diagrams
This example shows the stable Fe-C phase diagram (stable meaning that the graphite phase
is entered in the calculation). The same diagram is calculated using the Binary Calculator
activity and then using a System Definer and Equilibrium Calculator.

In both cases, a Plot Renderer is used to display results. The purpose of the Binary Calculator
is to simplify common calculations for binary systems. In the Equilibrium Calculator two axes
are defined:Mass percent C and Temperature. An axis variable must also be an equilibrium
condition.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_03_Fe-C_phase_diagram.tcu

This example is included as a tutorial on our website and our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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PLOT RESULTS
Equilibrium Calculator Results

This shows the plot result of the System Definer and Equilibrium Calculator system.
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Binary Calculator Results

T_04: Fe-Cr-C Ternary Phase Diagram at 1000 K
This example shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. Similar to
example "T_03: Fe-C Phase Diagrams" on page 10, the same diagram is calculated using a
Ternary Calculator and then using a System Definer and Equilibrium Calculator. Two Plot
Renderer activities are added to create two plots.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_04_Fe-Cr-C_ternary_phase_diagram.tcu

This example is included as a tutorial on our website and our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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PLOT RESULTS
Ternary Calculator
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Equilibrium Calculator

Try practicing with two features on the Plot Renderer Configuration window. To
toggle between a triangular and a rectangular diagram, click the Show
Triangular button then click Perform to see what happens. To toggle the X and
Y axis variables, click the Switch Axes button and then click Perform.
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T_05: Stable and the Metastable Fe-C Phase Diagrams
This example shows how to overlay results from two calculations in the same plot using the
Equilibrium Calculator.

1. The Plot Renderer activity is first created as a successor to Equilibrium Calculator 1.

2. Then right-click the Plot Renderer node and select Add predecessor and the results
from both equilibrium calculators are in the same plot. In Equilibrium Calculator 1
the stable phase diagram is calculated and in Equilibrium Calculator 2 the metastable
phase.

3. The metastable diagram is obtained by deselecting the graphite phase on System
Definer2 → Phases and phase constitution tab.

PROJECT FILE NAME

l Folder: Thermo-Calc

l File name: T_05_Fe-C_stable_and_metastable_phase_diagram.tcu



Graphical Mode Examples ǀ 16 of 138

PLOT RESULT

T_06: Serially Coupled Equilibrium Calculators
Sometimes there are multiple solutions for a given set of equilibrium conditions. In other
cases the equilibrium calculation does not converge. You can then aid the final calculation
by, in effect, telling the software where it should start the search for the equilibrium.

This example shows how to serially couple two Equilibrium Calculator nodes together for
more complex equilibrium conditions. For each calculation, the output is to a Table
Renderer.

PROJECT FILE NAME

l Folder: Thermo-Calc

l File name: T_06_Serial_equilibrium_calculators.tcu

Table Renderer Results

Equilibrium Calculator 1
In the first example, the objective is to calculate the equilibrium at 850° C where the mole
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fractions of the FCC A1 and BCC A2 phases are 0.5 each for an Fe-Cr-C steel with 10%
chromium. In Equilibrium Calculator 1 a simple set of equilibrium conditions (temperature,
pressure, system size and composition) are used to find a carbon content where only the FCC
A1 and BCC A2 phases are stable. The results from this preliminary calculation are displayed
in Table Renderer 1.

Equilibrium Calculator 2
In Equilibrium Calculator 2 the carbon content equilibrium condition is replaced by the
condition that the numbers of moles of the BCC A2 phase should be 0.5. The final result is
displayed in Table Renderer 2. In this case, the final objective is to calculate the solidus
temperature of an Fe-Cr-C steel with 10% Cr and 0.01% C.
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Equilibrium Calculator 3
In Equilibrium Calculator 3 the state at 2000 K is calculated and the result is displayed in
Table Renderer 3.
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Equilibrium Calculator 4
In Equilibrium Calculator 4 the temperature equilibrium condition is replaced by the
condition Fix phase / liquid / 0.0, meaning that liquid should be stable in an amount of zero
moles, i.e. the solidus temperature. The final result is displayed in Table Renderer 4.
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T_07: User-Defined Functions
This example shows how to implement user-defined functions.

A series of equilibria for an Fe-Cr-C alloy are calculated by varying temperature between
500 and 3000 K. In the configuration window of the Equilibrium Calculator under the
Functions tab, two identically meaning functions are defined, fraction solid and f solid, the
values of which are plotted against temperature in two Plot Renderer activities. Functions
can be entered in terms of QuantitiesQ1, Q2, Q3 and so forth, or by using the Thermo-Calc
syntax.

PROJECT FILE INFORMATION

l Folder: Thermo-Calc

l File name: T_07_User_defined_functions.tcu
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PLOT RESULT
This plot example shows the result of the fraction solid function.
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T_08: Scheil and Equilibrium Solidification
This example shows a comparison for an Al-Si alloy solidified under full local equilibrium and
under the Scheil assumptions, i.e. zero diffusion in the solidified material and infinitely fast
diffusion in the liquid. The example uses the Scheil Calculator and adds a Plot and Table
Renderer.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Thermo-Calc

l File name: T_08_Scheil_and_equilibrium_solidification.tcu.

For other examples of using Scheil, see our website and YouTube channel:

Modified Austenitic Stainless Steel 18/8 Scheil Solidification Simulation

Applications to Welding and Joining with Bonus Scheil Example

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/VRL_SsKLca0
https://youtu.be/Q-527CeTrH0
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TABLE AND PLOT RESULTS

The plot compares the mole fraction of a solid vs temperature. The table provides the data,
which you can also export.
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TO SAVE THE TABLE

There are two ways to save the table.

Method 1
In the Results window, right click the table and select Save As...

Method 2

1. In the Project window, click the Table Renderer.

2. In the Configuration window, click Save table.
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T_09: Carbide Driving Force Heat Map
This is an example of using Grid calculations to plot the driving force for a carbide as a
function of two composition variables. With the Grid calculation type, a 2D grid is generated
from the two calculation axes. After the calculation is done, an equilibrium is calculated in
each grid point. A Plot Renderer connected to a grid calculation plots the z-axis property for
each equilibrium as a function of the two calculation axes. The final plot can be either a heat
map or a contour plot.

PROJECT FILE NAME

l Folder: Thermo-Calc

l File name: T_09_Heat_map_of_carbide_driving_force.tcu

PLOT RESULT
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Thermo-Calc Property Model Examples Collection

The General models are available to all users. To run calculations with the
Steel models (martensite and pearlite) requires a valid maintenance license
plus licenses for both the TCFE9 and MOBFE4 databases.

These examples use the Property Model Calculator, an activity available with Thermo-Calc.

About the Examples

PM_G_01: Phase Transition
The example uses the Property Model Calculator to predict the transition temperature to
the unwanted brittle Sigma phase. The example shows how the temperature is influenced by
changes to a steel alloy’s composition using the uncertainty calculation type and how to
create either a histogram or probability plot.

Phase Transition Model in the Thermo-Calc User Guide.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Property models>General

l File name: PM_G_01_Phase_Transition.tcu

This example is included as a tutorial on our website and our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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PLOT RESULTS
Histogram plot

Probability plot
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Experienced users can also create custom property models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.

PM_G_02: Coarsening and Interfacial Energy
The example uses the Property Model Calculator and both thermodynamic (FEDEMO) and
kinetic (MFEDEMO) demonstration steel databases. Using a Grid calculation type it produces
these plots: a heat map, a contour plot and a cross plot with contour (where both the
interfacial energy and coarsening rate is shown). It also creates a diagram to show the
phase fractions vs time and a 3D plot comparing the coarsening rate coefficient.

Coarsening Model and Interfacial Energy Model

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Property models>General

l File name: PM_G_02_Coarsening_and_Interfacial_energy.tcu

This example is included as a tutorial on our website and our YouTube channel.

Plot Results

Coarsening rate coefficient (heat map)

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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Coarsening rate coefficient (3D plot)
Two different rotation angles. When viewing in Thermo-Calc you can rotate the plot.
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Coarsening rate coefficient (contour plot)
Coarsening rate coefficient
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Coarsening rate coefficient and Interfacial energy (overlayed plots)

Phase fractions vs T (One axis)

Experienced users can also create custom property models for use with the
Property Model Calculator.
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Search for Property Model Calculator and Development Framework in the help.

PM_G_03: Driving Force and Interfacial Energy
The example uses the Property Model Calculator and a thermodynamic demonstration steel
database (FEDEMO). Using a grid calculation type it produces a contour plot comparing the
driving force and interfacial energy.

Driving Force Model and Interfacial Energy Model in the Thermo-Calc User Guide.

PROJECT FILE AND VIDEO TUTORIAL INFORMATION

l Folder: Property models>General

l File name: PM_G_03_Driving_force_and_Interfacial_energy.tcu

This example is included as a tutorial on our website and our YouTube channel.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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PLOT RESULT
A contour plot

Phase Fraction
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Experienced users can also create custom property models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.

PM_Fe_01: Fe-Cr-C Martensite with Intercritical
Annealing

To run calculations with the Steel models (martensite and pearlite) requires a
valid maintenance license plus licenses for both the TCFE9 and MOBFE4
databases.

The example uses the Property Model Calculator with the Martensite Fractions and
Martensite Temperaturesmodels.

The example shows how to calculate martensite fractions and martensite temperatures
(martensite start, Ms, and 90% transformation temperature M90). The alloy is first
intercritically annealed and then quenched. Austenite composition is determined by an
equilibrium calculation at the annealing temperature. Martensite fraction is calculated as a
function of temperature which the alloy is quenched to. The example also shows how Cr
content in the alloy influences Ms and M90 after intercritical annealing.

REFERENCE

Harris, William J, and Morris Cohen. 1949. “Stabilization Of The Austenite-Martensite
Transformation.” Transactions of the American Society for Metals, AIME 180: 447–70.

PROJECT FILE INFORMATION

l Folder: Property models >Steel

l File name: PM_Fe_01_Fe-Cr-C_martensite_intercritical_annealing.tcu

PLOT RESULTS
Transformation curves
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The transformation curves plot showing Fe-Cr-C martensite with intercritical annealing.
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Ms-Mf

PM_Fe_02: Fe-Mn Martensite Morphologies

To run calculations with the Steel models (martensite and pearlite) requires a
valid maintenance license plus licenses for both the TCFE9 and MOBFE4
databases.

The example uses the Property Model Calculator with the Martensite Temperaturesmodel.
It shows the Ms temperatures of different types of martensites: lath, plate, and ε (hcp),
compared with experimental ε Ms values.
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PROJECT FILE INFORMATION

l Folder: Property Models>Steel

l File name: PM_Fe_02_Fe-Mn_martensite_morphologies.tcu

PLOT RESULT
Allmorphologies

A diagram showing all theMs temperatures of different types of martensite morphologies (lath,
plate and epsilon (hcp) compared with experimental epsilon Ms values.

PM_Fe_03: Fe-C-Mn Pearlite

To run calculations with the Steel models (martensite and pearlite) requires a
valid maintenance license plus licenses for both the TCFE9 and MOBFE4
databases.

The example uses the Property Model Calculator with the Pearlite model.
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The example shows how to calculate pearlite growth rate, lamellar spacing, and times of
start (2% transformation) and finish (98% transformation) as functions of isothermal heat
treating temperature in an Fe-0.69C-1.80Mn alloy (mass %). Withmaximize growth rate set
as the criterion, the model gives maximal growth rate and minimal lamellar spacing. With
optimal pearlite as the pearlite mode, the model optimizes partitioning of substitutional
alloying element(s) (Mn in this example) according to the criterion, which realizes a smooth
transition between ortho-pearlite at high temperature and para-pearlite at low
temperature.

REFERENCE

Razik, N.A, G.W. Lorimer, and N Ridley. 1974. “An Investigation of Manganese Partitioning
during the Austenite-Pearlite Transformation Using Analytical Electron Microscopy.” Acta
Metallurgica 22 (10): 1249–58. doi:10.1016/0001-6160(74)90138-2.

PROJECT FILE INFORMATION

l Folder: Property Models>Steel

l File name: PM_Fe_03_Fe-C-Mn_Pearlite.tcu

PLOT RESULTS
Growth Rate
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Lamellar Spacing
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TTT

The TTT (time-temperature-transformation) diagram showing times of start (2% transformation)
and finish (98% transformation) as functions of isothermal heat treating temperature in an Fe-
0.69C-1.80Mn alloy (mass %).
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Process Metallurgy Examples Collection

The Process Metallurgy Module works with TCOX8 and newer versions of the
database. The current version of the database is TCOX9.

All other users can test the module with the included OXDEMO database, which
is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For more information
about this and other products visit our website.

About the Examples

PMET_01: Basic Oxygen Furnace (BOF)

This example does not require a license to run the simulation. It works with both
the TCS Metal Oxide Solutions Database (TCOX versions 8 and 9 and newer) as
well as the free OXDEMO database.

The example uses the Process Metallurgy Calculator to demonstrate a simplified
steelmaking process in a Basic Oxygen Furnace (BOF).

The real-world BOF process is highly exothermic and needs adiabatic
calculations. These are not available with the current version of the Process
Metallurgy Module.

It is recommended you open the example project file and watch the companion video. The
video walks you through setting up the material groups as well as analyzing the results.

You can open the example project file from Thermo-Calc Help → Example Files
→ Process Metallurgy → PMET_01_Basic_Oxygen_Furnace.tcu.

This example is included as a tutorial on our website and our YouTube channel.

In general, the steps to set up this simulation are described in Defining the Process
Metallurgy Calculator. After setting up the steel, slag and gas system, you can generate
various plots to analyze the results. Below is a brief summary of this analysis.

https://www.thermocalc.com/start/
https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/playlist?list=PLfv6McToaTGS4g5LC9tjiqjCo9OX2-YOa
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See Phase Groups for details about how the Process Metallurgy Module plot labels are
grouped into the liquid metal, solid metal, solid oxides, liquid oxides and gas phases.

For this example, a One axis calculation type is used for all plots. The Grid Definition settings
for these plots are also set on the Process Metallurgy Calculator:

l Quantity: Amount of Oxygen (GAS)

l Stepping 0 min to 10 max with 40 steps

Amount of Phase Groups

After the plot is generated, by default you can see the Amount of phase group is plotted on
the Y-axis as a function of the quantity plotted on the X-axis, in this case the Amount of
Oxygen (GAS).
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Zooming into the low gas amount (see below), it can be seen that the evolution of the gas
phase is retarded. The reason is that the oxygen gas first oxidizes some of the silicon
dissolved in the steel to form silicon dioxide (SiO2). Only when the silicon content in the steel
has dropped below a certain level can the oxygen gas burn away the carbon dissolved in the
steel to form a carbon monoxide (CO)-rich gas phase.

These reactions can be investigated in more detail with different plots, so we will do that.

Composition of Liquid Metal

For the next plot, you define the following on a Plot Renderer, which you add to the Process
Metallurgy Calculator. Keep the X-axis setting. For the Y-axis, choose Composition of a
phase group, Liquid Metal, All elements.
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In the plot (that uses a linear axis) the reduction of the carbon content can be clearly seen.
This reduction of the carbon content is what is termed “steelmaking”. The hot metal coming
from the blast furnace has a very high carbon content of typically 4.5 wt%. If it is left to
solidify without lowering the carbon content, it will be extremely brittle and be unfit for
rolling or forging.

Other changes in steel chemistry occurring in the BOF can be made visible by changing the
Y-axis type from linear to logarithmic.

In the example project file only the logarithmic 10 version of the plot is
included.
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Now you can see the removal of the elements from the liquid steel in the following order:
first calcium, then aluminium, then silicon and finally carbon (Ca, Al, Si and C) according to
their position on the Ellingham diagram.

Composition of Liquid Slag

Add another Plot Renderer and define the following. Keep the X-axis setting. For the Y-axis,
choose Composition of a phase group, Liquid Oxides, All components.
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This plot shows how the liquid slag composition changes as a function of the amount of
oxygen added to the BOF.

At first, the SiO2 content of the slag rises sharply. This is due to the initial oxidation of the
silicon dissolve in the hot metal. The SiO2 that is formed combines with the slag and
increases its SiO2 content.

This increased SiO2 content reduces the liquidus temperature of the slag and, as you can see
in the first plot, thereby increases the amount of liquid slag and reduces the amount of solid
oxides. This is also exactly what happens in reality.

On further addition of oxygen to the liquid steel, the silicon dioxide (SiO2) content in the slag
increases further and further as more silicon is oxidized and combines with the slag. At the
same time the oxygen partial pressure in the steel slowly increases. After about 6 tonnes of
oxygen have been added to the system, the oxygen pressure is high enough to start oxidizing
the steel itself.
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The slag quickly becomes rich in iron oxide (FeO). When this starts happening, the
steelmaking process is complete and the steel is ready to be tapped into a ladle for further
steel refining.

PMET_02: Ladle Furnace

This example does not require a license to run the simulation. It works with both
the TCS Metal Oxide Solutions Database (TCOX versions 8 and 9 and newer) as
well as the free OXDEMO database.

The example uses the Process Metallurgy Calculator to represent a simplified steel refining
process in a ladle furnace (LF). It introduces you to the workflow of the Process Metallurgy
Module. It is recommended you open the example project file and watch the companion
video. The video walks you through setting up the material groups as well as analyzing the
results.

You can open the example project file from Thermo-Calc Help → Example Files
→ Process Metallurgy → PMET_02_Ladle_Furnace.tcu.

This example is included as a tutorial on our website and our YouTube channel.

In general, the steps to set up this simulation are described in Defining the Process
Metallurgy Calculator. After setting up the steel, slag and gas system, you can generate
various plots to analyze the results. Below is a brief summary of this analysis.

See Phase Groups for details about how the Process Metallurgy Module plot labels are
grouped into the liquid metal, solid metal, solid oxides, liquid oxides and gas phases.

https://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/playlist?list=PLfv6McToaTGS4g5LC9tjiqjCo9OX2-YOa
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The material saved for this example, Steel_LF, could be a typical, but simplified composition
of a fully killed SAE 1040 grade steel. The sulfur content, however, is too high for most final
applications and must be reduced. Sulfur is usually removed from liquid steel in a ladle
furnace using a calcium oxide-rich slag.

In this example, we want to find a slag composition that efficiently desulphurizes the steel.
For this particular calculation we choose not to define a constant amount of slag but instead
use absolute amounts of components. To do this, we set the Input type for the Slag material
group to use Absolute amount. After saving this composition, it becomes the slag material
for this example, Slag_LF.

For this example, the gas phase is not considered, which is why the Gas material
group has been removed in the example project. This does not mean that no gas
phase is allowed to form; it simply means that no gas phase is used to set the
calculation conditions.

For this example, a Grid calculation type is used for all plots. The Grid Definition settings for
these plots are also set on the Process Metallurgy Calculator:
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Leave the number of calculation steps at 10 for both axes in order to shorten
the calculation time. With this setting, the calculation should be completed in
just under one minute. The number of steps could be increased to maybe 30 x
30 for higher resolution of the results, but this increases the calculation time
significantly.

Fraction of Liquid Slag

In the example project file only the Ratio of liquid slag and sulfur in liquid steel
contour plot is included.

We want to understand whether our slag phase is liquid or not. To create the plot below, add
a Plot Renderer node with a Contour plot and choose Fraction of liquid slag as the Z-axis
variable. Set the interpolation as 50 x 50 and click Perform.
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The plot shows that for low amounts of aluminium oxide (Al2O3) and silicon dioxide (SiO2),
almost no liquid slag is present. Process metallurgists refer to this as a hard slag.

Such a hard slag is in fact just solid oxide phases that passively float on the liquid steel. It
does not react with the liquid steel for kinetic reasons and therefore does not desulfurize the
steel.

Practical slag compositions are limited to the top, right field above the “fraction liquid slag =
0.9” contour line. Only here a liquid slag phase is present that can flow and can mix and
react with the steel.

Next we are interested in the ability of the slag phase to remove sulfur (s) from the liquid
steel.

Sulfur in Liquid Steel
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Refer to the Sulfur in liquid steel 3D plot included with the example. The red colors in the
upper right-hand corner at high SiO2 and Al2O3 content show that the steel contains high
amounts of sulfur.

This means that only a little of the sulfur in the liquid steel partitioned into the slag phase
and the slag phase has a poor capacity to take up sulfur.

The blue colors in the lower left-hand corner indicate that the liquid steel contains only very
low amounts of sulfur, so this indicates a slag composition that is effective at removing
sulfur, or in other words, has a high sulfur capacity.

The performed calculations assume thermodynamic equilibrium. As shown in
the previous plot, there is almost no liquid slag phase present in the lower left
corner at low SiO2 and Al2O3 content. This means that thermodynamic
equilibrium would not be achieved due to the very slow kinetics of the reaction
between the liquid steel and the solid oxides.

Ratio of Liquid Slag and Sulfur in Liquid Steel

Refer to the Ratio of liquid slag and sulfur in liquid steel contour plot included with your
example. This is two plots combined into one contour plot. If you created the above Fraction
of Liquid Slag contour plot, this plot is created simply by adding another set of axes and then
defining the Z-axis.

Combining the information contained in the two plots results in an optimum slag
composition in a narrow composition band. To smooth the contours, Set the interpolation as
50 x 50.
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To map this optimal composition field one more plot can be generated by superimposing
contour plots of sulfur content in the liquid steel and fraction of liquid slag.

Since we want to have at least 95% liquid slag, in the set of axis variables for Fraction of
liquid slag, click to select the check box next to Use custom contour values and enter 0.95
in the field.

We also want to have less than 0.005% sulfur in the liquid metal, so also select the same
check box for the other Z-axes and set the value of sulfur to 0.005 . Click Perform.
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The optimal slag has a composition delimited by these two contour lines, so below the
contour line for sulfur content in the liquid steel and above the contour line for fraction of
liquid slag will be both fully liquid and effectively desulfurizes the steel.
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Diffusion Module (DICTRA) Graphical Mode Examples

Examples using up to three elements are available to all users. The other
examples require a Diffusion Module (DICTRA) license to calculate and plot
results.

These examples use the Diffusion Calculator. All examples use demonstration database
packages included with your installation no matter what licenses you have.

About the Examples

D_01 Homogenization of a Binary Fe-Ni Alloy
The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in
a planar domain. At this temperature the material is fully austenitic, i.e. the only phase
present is the so-called fcc (face centered cubic) phase. Initially, there is a linear variation in
Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

This example is available as a video tutorial on our website and YouTube
channel. In previous versions of the software (prior to 2017b) it is example 19.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/H5xA3_uCHbc
https://youtu.be/H5xA3_uCHbc
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Composition of Ni vs Distance

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_01_Diffusion_Single_Phase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.
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D_02 Ferrite(bcc)/Austenite(fcc) Transformation in a
Binary Fe-C Alloy
The moving phase boundary example simulates the growth of ferrite (bcc) into austenite
(fcc). The austenite is assumed to be initially homogeneous with the composition Fe-0.15
mass-% C. The transformation temperature is 1050 K. The initial thickness of the austenite is
2 mm and an initially very thin ferrite (1 nm) is also present at the start of the simulation.

This example is available as a video tutorial on our website and YouTube
channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/03cTmXS1AV8
https://youtu.be/03cTmXS1AV8
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Position of interface vs time
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Composition profile C

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_02_Diffusion_Moving_Boundary.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.
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D_03 Evolution of an Fe-Cr-Ni Diffusion Couple
The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100
hour heat treatment at 1100° C (1373.15 K). Both end members of the diffusion couple are
duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and
austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid
point, i.e. the local phase fractions, phase compositions and so forth are obtained from an
equilibrium calculation with the local overall composition as a condition.

More details about the homogenization model for multiphase simulations can be found in
Larsson and Engström (2006)1. and Larsson and Höglund (2009)2. . Experimental data is from
Engström (1995)3. .

1. "A homogenization approach to diffusion simulations applied to α + γ Fe–Cr–Ni diffusion couples", Acta Mater., 54 (9),
pp. 2431–2439.
2. "Multiphase diffusion simulations in 1D using the DICTRA homogenization model", Calphad, 33 (3), pp. 495–501.
3. "Interdiffusion in multiphase, Fe-Cr-Ni diffusion couples", Scand. J. Metall., 24(1), 12–20.
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Phase fraction of FCC

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_03_Diffusion_Multiphase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.

D_04 Fe-C Moving Boundary: Austenite to Ferrite
This example simulates the austenite to ferrite transformation in a Fe-0.01 mass% C steel
during continuous cooling. The simulation starts at a temperature where only austenite is
stable, ferrite nucleates and grows into the austenite during cooling in the two phase region.
Plots of thermal and carbon composition profiles are generated.
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Thermal profile
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Carbon composition profile

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_04_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu

This example is available to all users.
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D_05 γ/α/γ Diffusion couple of Fe-Ni-Cr alloys
This example demonstrates the evolution of a ternary Fe-Cr-Ni diffusion couple. A thin slice
of ferrite (α phase) (38%Cr,0%Ni) is clamped between two thicker slices of austenite (γ
phase) (27%Cr, 20%Ni). The assembly is subsequently heat treated at 1373 K.

This set up corresponds to diffusion couple in Kajihara, Lim, and Kikuchi (1993)1. . Also see
Kajihara and Kikuchi (1993)2. .

1. "Experimental Study on Dissolution of ALPHA Phase in GAMMA/ALPHA/GAMMA Diffusion Couples of the Fe-Cr-Ni
System", ISIJ Int., 33(4), 498–507.
2. "Numerical analysis of dissolution of α phase in γ/α/γ diffusion couples of the Fe-Cr-Ni system", Acta Metall. Mat., 41
(7), 2045–2059.
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Interface Position
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Concentration profiles at 3600 s
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Concentration profiles at 36000 s
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Concentration profiles at 36 0000 s



Graphical Mode Examples ǀ 69 of 138

Concentration profiles at 3 600 000 s
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Diffusion paths

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_05_Diffusion_Fe_Ni_Cr_Moving_Boundary_Diffusion_Couple.tcu

D_06 Diffusion Through a Tube Wall
This is a simple example of diffusion through a tube wall . The tube material is an Fe-
0.06Mn-0.05C alloy. Two plots comparing distance to the U-fraction of manganese and
composition of carbon are generated to visualize the austenite region. A cylindrical
geometry is used withmixed zero flux and activity boundary conditions.

On the inside wall a carbon activity of 0.9 is maintained whereas on the outside the carbon
activity is very low. This example demonstrates the use of boundary conditions, advanced
plotting and tables.

This example is based on Console Mode exab6. When in Console Mode, you can
open the example from Thermo-Calc (File → Examples Files → Diffusion
Module).
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Composition of C vs Distance
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U-fraction of Mn vs Distance

Table Composition C vs Distance
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PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_06_Diffusion_Carburization_Tube.tcu

D_07 Multiphase Carburization of a Ni-25Cr-0.0001C
alloy
This example is about carburization of a Ni-25Cr-0.0001C alloy. In this case the M7C3 and
M3C2 carbides are entered as spheroid phases in an FCC_A1 matrix. It is similar to
Graphical Mode example D_06 except the default Simulation condition is automatically set
to use the Homogenization model.

The Isothermal calculation is run for 1000 hours at a temperature of 1123 K using the Mixed
zero flux and activity left boundary condition. Results are plotted using two Plot Renderers
and a Table Renderer.

This case is from Engström, Höglund, and Ågren (1994), "Computer simulation of diffusion in
multiphase systems", Met. Mat. Trans. A, 25(6), 1127–1134.

This example is based on Console Mode exd1b. When in Console Mode, you can
open the example from Thermo-Calc (File → Examples Files → Diffusion
Module).

This example is available as a video tutorial on our website and YouTube
channel.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/BiaJSiWdw4U
https://youtu.be/BiaJSiWdw4U
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Phase fraction vs distance
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Table of Composition profiles
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Composition of C vs Distance

PROJECT FILE NAME

l Folder: Diffusion Module - DICTRA

l File name: D_07_Diffusion_Carburization_Multiphase.tcu
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Precipitation Module (TC-PRISMA) Graphical Mode
Examples

Examples that use up to three elements are available to all users. The other
examples require a Precipitation Module (TC-PRISMA) license to calculate and
plot results.

All examples use demonstration database packages included with your
installation. You can open the examples from the main menu: File → or Help →
Examples Files.

Unless specified in tables for each example, all the numerical parameters are
assumed default values.

P_01:  Isothermal Precipitation of Al3Sc
This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase.
The simulation results can be compared with experimental data collected from Marquis and
Seidman1. and Novotny and Ardell (2001)2. .

PROJECT FILE, STEP-BY STEP INSTRUCTIONS AND VIDEO INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_01_Precipitation_Al-Sc_AL3SC.tcu

This example is available as a video tutorial on our website and YouTube
channel.

You can also use the step-by-step instructions included in a PDF to follow the
video or compare to the project file in Thermo-Calc.

EXAMPLE SETTINGS

1.Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates in Al(Sc) Alloys.” Acta
Materialia 49 (11): 1909–19.
2.Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.” Materials Science &
Engineering, A: Structural Materials: Properties, Microstructure and Processing 318 (1–2): 144–54.

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/U05n2y9oB_s
https://youtu.be/U05n2y9oB_s
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System (System Definer)

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

Precipitate phase AL3SC

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy Calculated

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E7 seconds

PLOT RESULTS



Graphical Mode Examples ǀ 79 of 138

Mean radius
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Isothermal Precipitation Calculation: Example P_01 – 
Precipitation Al-Sc AL3SC 

This example shows you how to set up an isothermal precipitation calculation for the formation of 
AL3SC in an aluminium-scandium alloy at 350° using the Precipitation module (TC-PRISMA).  

This is one of the most basic calculations using the Precipitation module (TC-PRISMA), so it is a good 
place to start if you are new to this simulation type.  

HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here:  
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation module example P_01 – Precipitation Al-Sc AL3SC, 
which is included in your installation. To run the example file, open Thermo-Calc and select Help 
> Examples Files. Open the Precipitation module (TC-PRISMA) folder. Double-click the example 
file and click Perform at the bottom centre of the Configuration window in Thermo-Calc.  

 

ABOUT THE EXAMPLE  

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase. 

SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. Under templates, click Precipitation Simulation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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4. Click the System Definer 1 node.  
5. Set the database package to DEMO: Aluminium based alloys, which loads both 

thermodynamic and kinetic demonstration aluminium databases.  
6. From the periodic table, select the elements Al (aluminium) then Sc (scandium). Be sure to 

select Al first so that it is the dependant element.  
7. Just to the right of the periodic table, select Mole Percent as the Amount. 
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.  
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Our system is now defined, but before we start the precipitation calculation, we will do a quick one 
axis calculation to find the phases present around 350°.  

ONE AXIS CALCULATION 

Why We Do This 

In order to set up an isothermal precipitation calculation, we need to know which phases are present 
at 350°. A one axis calculation gives us this information.  

Setting up a One Axis Calculation 

1. In the Project window, right-click the System Definer 1 node, and from the Create New 
Successor menu select Equilibrium Calculator.  

2. In the Configuration window, select a Temperature in Celsius and enter 300. 
3. Under Calculation Type, select One axis.  
4. We are looking for the phases present around 350 degrees, so under Axis Definitions enter 

the Temperature range from Min 300 to Max 700 to capture the temperature wanted.  
5. Keep the default values for everything else.  
6. Our system is now defined. 

 

7. Right-click the Equilibrium Calculator node and select Create New Successor>Plot Renderer.  
8. In the Project window, right-click the Plot Renderer 2 node you just created and select 

Perform Now.  

Interpreting the Results of the One Axis Calculation 

Once the calculation is complete, a plot is displayed in the Results window. This plot shows you 
which phases are present at each temperature between 300° and 700° and the amount of that phase 
at each temperature. 
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If you hover your cursor over any of the lines on the plot, a label gives you the name of the phase, 
the temperature and the amount of the phase at that temperature.   

We can see that there are two phases present at 350°. FCC_A1 is at the very top of the plot and 
makes up more than 99% of the system. The remainder of the system is made up of Al3SC, which is 
near the very bottom of the plot and is the precipitate phase in the alloy we are considering.  

Remember these two phases because we will use them in our precipitation calculation.  
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PRECIPITATION CALCULATION 

Setting up the Precipitation Calculation 

1. In the Project window, click the Precipitation Calculator 1 node.  
2. Notice that the composition we set in the System Definer auto-populated here.  
3. Under Matrix Phase, select FCC_A1, which is the primary phase we saw present in the one 

axis calculation.  

NOTE: If you do not see any phases listed here it is probably because you do not have a kinetic 
database selected. If so, simply go back to the System Definer and add a kinetic (mobility) database.  

4. Under Precipitate Phase select AL3SC from the Phase menu because that is the other phase 
present around 350°, as shown in the one axis calculation.  

5. Accept the default settings in the Precipitate Phase section. You could choose to define your 
own interfacial energy settings if you have them.  

6. Under Calculation Type, make sure Isothermal is selected.  
7. Enter 350 as the Temperature and select Celsius.  
8. Enter 1.0E7 as the Simulation time and select Seconds, which is ten million seconds.  

 

9. In the Project window, click the Plot Renderer 1 node. 
10. Under Y-axes, from the Axis type menu select Logarithmic 10 for a better view of the plot. 
11. Click Perform at the bottom, centre of the Configuration window.  
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Interpreting the Results of the Precipitation Calculation 

Once the calculation is complete, your plot is shown in the Results window. 

  

At the beginning, which is the left-most side of the plot, the mean radius is quite small and then 
grows rapidly over time, which is represented by moving rightward on the plot.  

This plot shows the 
Mean radius of the 
AL3SC precipitate as a 
function of time.  



Isothermal Precipitation Calculation 
Example P_01 – Precipitation Al-Sc AL3SC 

 

Page 7 of 7 
 

Setting Other Variables in the Precipitation module (TC-PRISMA) 

The Precipitation module (TC-PRISMA) offers many variables that you can plot for the same 
calculation.  

1. Click the Plot Renderer 1 node. 
2. In the Y-axes section, select the Axis variable menu to see what other options are available.  
3. Once you have made your selection, click Perform at the bottom, centre of the Configuration 

window to create a new plot.   
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P_02: Stable and Metastable Carbides - Isothermal
This example simulates the kinetics of precipitation of both stable and metastable carbides
from ferrite phase. It demonstrates that metastable carbides (cementite, M7C3) may first
emerge and then disappear and the stable phase (M23C6) prevails.

This example uses the Equilibrium Calculator and a One axis calculation to determine how
the phases change with temperature. We are interested in the carbide precipitation at
1053K where only the carbide M23C6 is stable according to the equilibrium calculation. The
Precipitation Calculator is used to do an isothermal calculation of the three phases
(cementite, M23C6 and M7C3) where cementite and M7C3 are metastable phases.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6.tcu

EXAMPLE SETTINGS

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size (click Show details to display this
setting) 1.0E-4 m

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282
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J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

PLOT RESULTS
Equilibrium Calculator: How the phases changewith temperature



Graphical Mode Examples ǀ 89 of 138

Precipitation Calculator: Volume fractions

P_03: Stable and Metastable Carbides - TTT Diagram
In this example, the kinetics of precipitation of both stable and metastable carbides is
calculated from the ferrite phase. It demonstrates that metastable carbides may first
emerge and then disappear and the stable phase prevails.

This example uses the Equilibrium Calculator and a One axis calculation type to determine
how the phases change with temperature. Using this result, the Precipitation Calculator is
used to do a TTT (Time-Temperature-Transformation) diagram calculation of the three
phases (cementite, M23C6 and M7C3) at the grain boundaries.

For a TTT diagram calculation, select TTT diagram in Calculation Type, then enter Min,
Max, and Step of Tempeature, as well asMax annealing time. In Stop criterion, choose
Volume fraction of phase and enter the value.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_03_Precipitation_Fe-C-Cr_TTT_Cementite-M7C3-M23C6.tcu

EXAMPLE SETTINGS
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System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and
MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)

Grain size (click Show details to display this setting) 1.0E-4 m

Precipitate Phase Data Parameters

Nucleation sites Grain boundaries

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3
0.282 J/m2

Calculation Type (Precipitation Calculator)

Calculation type TTT diagram

Temperature 500° to 800° C with 25° C steps

Max. annealing time 1.0E8 seconds

Stop criteria Volume fraction of phase is set to 0.0001

Options > Numerical Parameters

No. of grid points over one order of magnitude in
radius 150

Max no. of grid points over one order of magnitude
in radius 200

Min no. of grid points over one order of magnitude
in radius 100
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PLOT RESULTS
Equilibrium Calculator: How the phases changewith temperature

Precipitation Calculator: TTT diagram
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P_04: Precipitation of Iron Carbon Cementite
Simulate the kinetics of precipitation of carbides from a BCC Fe solution phase. This example
is based on Wert (1949)1. .

This example uses two Experimental File Reader activities with the Precipitation Calculator
and an isothermal calculation, to plot the volume fraction of the cementite phase.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_04_Precipitation_Fe-C_Cemetite.tcu

EXAMPLE SETTINGS

System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and
MFEDEMO)

Elements Fe, C

Conditions (Precipitation Calculator)

Composition Fe-0.016C mass percent

Matrix phase BCC_A2

Precipitate phase Cementite

Matrix Phase Data Parameters (Precipitation Calculator)

Grain aspect ratio (click Show details to display this
setting) 1.0

1.Wert, Charles A. 1949. “Precipitation from Solid Solutions of C and N in α-Iron.” Journal of Applied Physics 20 (10). AIP
Publishing: 943.



Graphical Mode Examples ǀ 93 of 138

Dislocation density (click Show details to display this
setting) 1.5e11m-3

Precipitate Phase Parameters (Precipitation Calculator)

Nucleation sites Dislocations

Interfacial energy 0.24 J/m2

Growth rate model (click Show details) Advanced

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 102° C

Simulation time 600 000 seconds
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PLOT RESULTS
Volume Fraction

P_05: Precipitation of γ’ in Ni Superalloys -
Isothermal
This example simulates the kinetics of precipitation of γ’ phase from γ phase. The simulation
results can be compared with experimental data collected from Sudbrack et al. (2008)1. .

This example uses three Experimental File Reader activities with the Precipitation
Calculator. It does an isothermal calculation to plot the volume fraction, mean radius and
number density of the cementite phase.

DIS_FCC_A1 needs to be selected on the System Definer.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

1. Sudbrack, Chantal K., Tiffany D. Ziebell, Ronald D. Noebe, and David N. Seidman. 2008. “Effects of a Tungsten Addition on
the Morphological Evolution, Spatial Correlations and Temporal Evolution of a Model Ni–Al–Cr Superalloy.” Acta Materialia
56 (3): 448–63.
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l File name: P_05_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime.tcu

EXAMPLE SETTINGS

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al Cr

Conditions (Precipitation Calculator)

Composition Ni-9.8Al-8.3Cr Mole percent

Matrix phase DIS-FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.012 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 800° C

Simulation time 1 000 000 seconds

PLOT RESULTS
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Volume Fraction

Number Density
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Mean Radius

P_06: Precipitation of γ’ in Ni Superalloys - Non-
isothermal
This example simulates the kinetics of precipitation of γ’ phase from γ phase in Ni-8Al-8Cr
and Ni-10Al-10Cr at.% alloys during continuous cooling. The simulation results can be
compared with experimental results from Rojhirunsakool et al. (2013)1. .

When you run (Perform) this example, it takes about 10 minutes for the
calculations to complete.

DIS_FCC_A1 needs to be selected on the System Definer.

1. Rojhirunsakool, Tanaporn, S. Meher, J. Y. Hwang, S. Nag, J. Tiley, and Rajarshi Banerjee. 2013. “Influence of Composition
on Monomodal versus Multimodal Γ′ Precipitation in Ni–Al–Cr Alloys.” Journal of Materials Science 48 (2): 825–31.
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PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_06_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_prime.tcu

EXAMPLE SETTINGS

In these examples a linear, continuously cooling condition is set up. This is done on the
Precipitation Calculator settings window in the Calculation Type section:

1. Select a Non-Isothermal.

2. Select a Temperature Unit and Time Unit from the lists.

3. Click Thermal Profile, where Time-Temperature profile points are entered to
describe the stepwise heat treatment schedule with linear segments. Up to 999 rows
of data points can be entered.

In these examples two rows of data points are needed for starting time 0s and
temperature 1150° C, as well as end time 3300s and temperature 380° C.

4. Click the Plot Renderer node to select the Separate multimodal PSD check box.

Plotting the size distribution from the final simulation time of 3300 seconds, you can
see there are several peaks, although these are not completely separated. As above,
select the Separate multimodal PSD check box to separate the peaks.

5. Adjust the Valley depth ratio setting to 0.05 to separate into two peaks as shown in
the Ni-10Al-10Cr plot example. You can experiment with this setting to see how the
size distribution evolves with time, for example, try entering several values as plot
times 400 600 3300.

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition (Ni-8Al-8Cr) Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr) Ni-10Al-10Cr Mole percent
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Matrix phase DIS_FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility enhancement prefactor (click
Show details to display this setting) 5.0

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type Non-isothermal

Temperature unit Celsius

Time unit Seconds

Simulation time (Ni-8Al-8Cr) 1470 s

Simulation time (Ni-10Al-10Cr) 3300 s

Multimodal PSD (Plot Renderer)

Separate multimodal PSD for 8Al-8Cr The Valley depth ratio is set to 0.05 for both plots. The number
of Points is increased to 200 for an average radius plot.

Separate multimodal PSD for 10Al-
10Cr The Valley depth ratio is set to 0.18 for both plots.

PLOT RESULTS
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Mean Radius Ni-8Al-8Cr

Mean Radius Ni-10Al-10CR
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Size Distribution (PSD) Ni-8Al-8Cr

Size Distribution (PSD) Ni-10Al-10Cr
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P_07: Continuous Cooling Transformation
(CCT) Diagram of Ni-Al-Cr γ-γ’
In this example, a Continuous Cooling Transformation (CCT) diagram for a Ni-10Al-10Cr γ-γ’
alloy is calculated and plotted with superimposition of the cooling rate values.

PROJECT FILE, STEP-BY STEP INSTRUCTIONS AND VIDEO INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_07_Precipitation_Ni-Al-Cr_CCT_Gamma-Gamma_prime.tcu

This example is available as a video tutorial on our website and YouTube
channel.

You can also use the step-by-step instructions included in a PDF to follow the
video or compare to the project file in Thermo-Calc.

EXAMPLE SETTINGS

System (System Definer)

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Conditions (Precipitation Calculator)

Composition Ni-10Al-10Cr Mole percent

Matrix phase DIS_FCC_A1

Precipitate phase FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/0q3iNyOKV1k
https://youtu.be/0q3iNyOKV1k
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Interfacial energy 0.023 J/m2

Calculation Type (Precipitation Calculator)

Calculation type CCT Diagram

Temperature Min to Max 500 to 1200 Kelvin

Cooling rate(s) .01 .1 1 10 100 K/s

Stop criteria Volume fraction of phase 1.0E-4

PLOT AND TABLE RESULTS
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Continuous Cooling Transformation (CCT) Diagram of 
Ni-Al-Cr γ-γ’: Precipitation Example P_07 

HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here: 
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation module example P_07 – Precipitation NI-Al-
Cr_CCT_Gamma-Gamma_prime, which is included in your installation. To run the example file, 
open Thermo-Calc and select Help > Examples Files. Open the Precipitation module (TC-PRISMA) 
folder. Double-click the example file and click Perform at the bottom centre of the Configuration 
window in Thermo-Calc. 

 

ABOUT THE EXAMPLE  

This example shows you how to simulate a CCT diagram for gamma prime (γ’) precipitation in a Ni-Cr-
Al alloy using the Precipitation module known as TC-PRISMA.  

CCT stands for Continuous Cooling Transformation and is a calculation that maintains the same 
cooling rate the entire time.  

The system is a Ni-10Al-10Cr γ - γ’ alloy and it is calculated and plotted with superimposition of the 
cooling rate values using the Precipitation module (TC-PRISMA).  

SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. Under templates, click Precipitation Simulation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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4. Click the System Definer 1 node.  
5. Set the database package to DEMO: Nickel based superalloys, which loads both 

thermodynamic and kinetic demonstration nickel databases. 
6. From the periodic table, select the elements Ni (nickel), Al (aluminium) then Cr (chromium). 

Be sure to select Ni first so that it is the dependant element.  
7. Just to the right of the periodic table, select Mole Percent as the Amount. 
8. Enter 10 for Al and 10 for Cr, which automatically sets Ni to 80 mole percent. 
9. Click the Phases and Phase Constitution tab. 

 

7 

5 

4 

6a 6c 
8 

6b 

9 
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10. Click to select both check boxes next to the disordered FCC phase, DIS_FCC_A1. 

Our system is now defined, so we will set up the precipitation calculation.  

SETTING UP THE PRECIPITATION CALCULATION 

1. In the Project window, click the Precipitation Calculator 1 node.  
2. Notice that the composition we set in the System Definer auto-populated here.  
3. Under Matrix Phase, from the Phase list select Dis_FCC_A1, which is the disordered FCC 

phase.  
4. Under Precipitate Phase from the Phase list select FCC_L12#2.  
5. Change the Interfacial energy to User-defined then enter 0.023 in the field.  
6. Under Calculation Type, select CCT Diagram, which stands for Continuous-Cooling-

Transformation and means that the same cooling rate is maintained throughout the 
calculation.  

7. In the fields, set the Min (minimum) Temperature to 500 and the Max (maximum) to 1200 
and choose Kelvin as the temperature unit. 

8. We will enter several cooling rates for our calculation. The rates are separated by a space, so 
enter these values as shown: .01 .1 1 10 100.  

9. Keep the default Stop criteria of 1E-4 volume fraction of the γ’ phase. 
10. The calculation is now set, so click Perform CCT Diagram Simulation at the bottom, centre of 

the Configuration window.  

10 
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INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATION 

 

In this plot, the blue line shows the time it takes for γ’ to transform at each of the cooling rates 
according to the stop criteria, which we set as 1e-4 volume fraction. The cooling rates are 
represented by the multi-coloured curved lines. 

In this plot, the blue, 
horizontal line shows the 
time it takes for gamma 
prime to transform at 
each of the cooling rates 
according to the stop 
criteria, which we set as 
1e-4 volume fraction.   
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If you hover your mouse over the intersection of the blue line and any of the vertical lines, a yellow 
box shows the approximate time it takes for γ’ to transform according to the stop criteria, which is a 
volume fraction of 1e-4, followed by the approximate temperature. In the image above, we can see a 
time of 0.54147 seconds and a temperature of 1147.60 Kelvin for the cooling rate of 100.0 K/s, which 
is represented by the yellow line.  

SHOWING THE RESULTS AS A TABLE 

You can also view these results in the form of a table, which gives you more precise results.  

1. In the Project window, right-click the Precipitation Calculator 1 node and select Create New 
Successor>Table Renderer.  

2. Right-click the Table Renderer 1 node and select Perform Now.  

 
Your table is shown in the Results window and shows the same information as in the plot - for each 
cooling rate the temperature and the time it takes for γ’ to transform according to the stop criteria, 
which is a volume fraction of 1e-4.  
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P_08: Precipitation of Cu-Ti CU4TI with Assumptions
of Sphere and Needle Morphologies
In this isothermal calculation example, the precipitation of Cu4Ti phase in a Cu-Ti binary
alloy is calculated. To make a comparison, two separate simulations are performed, one
assuming spherical morphology without elastic strain energy, and the other assuming needle
morphology whose shape, determined by competition between interfacial energy and elastic
strain energy, is changed during the simulation. The transformation strain is obtained from
Borchers1. . The results are compared with experiment results from Kampmann et al2. .

This example takes a few minutes to run.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_08_Precipitation_Cu-Ti_CU4TI1_Sphere_Needle.tcu

EXAMPLE SETTINGS

To ensure that the settings are done on the correct Precipitation Calculators, the
Sphere and Needle nodes are renamed from Precipitation Calculator to match
their morphology. The morphology is set in the Precipitate Phase section when
you click Show details.

System (System Definer)

Database package Demo: Copper-based alloys (CUDEMO and MCUDEMO)

Elements Cu, Ti

Sphere and Needle Conditions (Precipitation Calculator)

Composition Cu-1.9Ti Mole percent

Matrix phase FCC_L12

1. Borchers C. 1999. "Catastrophic Nucleation during Decomposition of Cu-0.9at.%Ti." Phil. Mag. A 79(3):537-547
2. Kampmann R., Eckerlebe H., and Wagner R. 1987. "Precipitation Kinetics in Metastab le Solid Solutions - Theoretical
Considerations and Application to Cu-Ti Alloys." Mat. Res. Soc. Symp. Proc. 57: 525-542.
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Precipitate phase CU4TI1

Matrix Phase Data Parameters (Precipitation Calculator)

Mobility enhancement
prefactor (click Show details
to display this setting)

100

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default

Morphology (click Show
details to display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the
default.

For the Needle node (renamed from Precipitation Calculator), Needle is
selected.

Transformation strain (click
Show details to display this
setting)

For the Sphere node (renamed from Precipitation Calculator), keep the
default.

For the Needlenode (renamed from Precipitation Calculator), User
defined is selected. In this example, the following settings are defined:

l ε11 and ε22 are set to 0.022

l ε33 is set to 0.003

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 10,000 seconds

Datasets (Experimental File Reader)

Borchers Mean radius vs Time
and Borchers Number density
vs Time

Data sets included with this example and imported to two Experimental
File Readers. These data sets are used for the Mean Radius and Number
Density plots, respectively.

PLOT RESULTS
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Mean Aspect Ratio
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Number Density
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PSD and ASD
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Mean Radius

P_09: Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
In this isothermal calculation example, the precipitation of Al3Sc phase from FCC_A1 matrix
phase in an Al-Sc binary alloy is simulated. To make a comparison, two separate calculations
are performed, one assuming spherical morphology without elastic strain energy, and the
other assuming cuboid morphology whose shape is determined by competition between
interfacial energy and elastic strain energy. The simulation results are compared with
experimental data collected from Marquis and Seidman1. and Novotny and Ardell (2001)2. .
In addition, mean cubic factor and cubic factor distribution are also plotted for cuboid shape
to illustrate the spherical-cuboidal transition during precipitation.

PROJECT FILE, STEP-BY STEP INSTRUCTIONS AND VIDEO INFORMATION

1.Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates in Al(Sc) Alloys.” Acta
Materialia 49 (11): 1909–19.
2.Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.” Materials Science &
Engineering, A: Structural Materials: Properties, Microstructure and Processing 318 (1–2): 144–54.
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l Folder: Precipitation Module - TC-PRISMA

l File name: P_09_Precipitation_Al-Sc_AL3SC_Sphere_Cuboid.tcu

This example is available as a video tutorial on our website and YouTube
channel.

You can also use the step-by-step instructions included in a PDF to follow the
video or compare to the project file in Thermo-Calc.

EXAMPLE SETTINGS

To ensure that the settings are done on the correct Precipitation Calculators, the
Sphere and Cuboid nodes are renamed from Precipitation Calculator to match
their morphology. The morphology is set in the Precipitate Phase section when
you click Show details. See P_08 for an example of this.

System (System Definer)

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Sphere and Cuboid Conditions (Precipitation Calculator)

Composition Al-0.18Sc Mole percent

Matrix phase FCC_A1

https://www.thermocalc.com/training/video-tutorials/
https://youtu.be/PdtXLFFbqJA
https://youtu.be/PdtXLFFbqJA
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Precipitate phase AL3SC

Matrix Phase Data Parameters (Precipitation Calculator)

Elastic properties
(click Show details to
display this setting)

For the Sphere node (renamed from Precipitation Calculator), the default,
Disregard is kept.

For the Cuboid node (renamed from Precipitation Calculator), choose Cubic. Then
enter the elastic constants accordingly. Default elastic constants are given based
on the major element of the alloy system. In this example that is

l c11 is 108.2 GPa

l c12 is 61.3 GPa

l c44 is 28.5 GPa

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Bulk

Interfacial energy The default

Morphology (click
Show details to
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default.

For the Cuboid node (renamed from Precipitation Calculator), Cuboid is selected.

Transformation
strain (click Show
details to display this
setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default.

For the Cuboid node (renamed from Precipitation Calculator), Calculate from
molar volume is selected to obtain a purely dilatational strain.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 350° C

Simulation time 1.0E9 seconds

Datasets (Experimental File Reader)

Dataset 1 and
Dataset 2

Data sets included with this example and imported to one Experimental File
Reader. It is used for the Mean Radius plot.

PLOT RESULTS
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Mean Radius
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PSD



Graphical Mode Examples ǀ 120 of 138

Mean Radius and Cubic Factor
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PSD and Cubic Factor
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Precipitation of Al-Sc AL3SC with Assumption of 
Sphere and Cuboid Morphologies: Precipitation 
Example P_09 
HELPFUL INFORMATION 

• All users can run this calculation, even those who do not have a license for the Precipitation 
module (TC-PRISMA).  

• A companion video is available for this example , which can be watched here: 
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ 

• This calculation is based on Precipitation module example P_09 – Precipitation_Al-
Sc_AL3SC_Sphere_Cuboid, which is included in your installation. To run the example file, open 
Thermo-Calc and select Help > Examples Files. Open the Precipitation module (TC-PRISMA) 
folder. Double-click the example file and click Perform at the bottom centre of the Configuration 
window in Thermo-Calc.  

 

ABOUT THE EXAMPLE  

This example shows you how to calculate the precipitation of Al3Sc phase from FCC_A1 matrix phase 
in an Al-Sc binary alloy using the Precipitation module (TC-PRISMA).  

Two separate calculations are performed so you can make a comparison of the results, one assuming 
spherical morphology without elastic strain energy, and the other assuming cuboid morphology 
whose shape is determined by competition between interfacial energy and elastic strain energy.  

In addition, mean cubic factor and cubic factor distribution are plotted for cuboid shape to illustrate 
the spherical-cuboidal transition during precipitation.  

If you run the example file included in your software, the simulation results are compared with 
experimental data collected from Marquis and Seidman (2001) and Novotny and Ardell (2001). 

https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
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SETTING UP THE SYSTEM 

1. Open Thermo-Calc in Graphical Mode.  
2. Under templates, click Precipitation Simulation. 
3. All the nodes for a precipitation calculation are added to the Project window:  

 

4. Click the System Definer 1 node.  
5. Set the database package to DEMO: Aluminium based alloys, which loads both 

thermodynamic and kinetic demonstration aluminium databases.  
6. From the periodic table, select the elements Al (aluminium) then Sc (scandium). Be sure to 

select Al first so that it is the dependant element.  
7. Just to the right of the periodic table, select Mole Percent as the Amount. 
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.  
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Our system is now defined, so we will set up the precipitation calculations.  

SETTING UP THE PRECIPITATION CALCULATIONS 

We will have two precipitation calculations in this example, one assuming spherical morphology 
without elastic strain energy, and the other assuming cuboid morphology whose shape is determined 
by competition between interfacial energy and elastic strain energy. We will then compare the 
results of the two calculations.  

Setting up the Precipitation Calculation with Spherical Morphology 

1.  In the Project window, right-click the Precipitation Calculator 1 node and select Rename. 
Enter Sphere, then press enter or click OK. 

 
2. Notice that the composition we set in the System Definer auto-populated here.  
3. Under Matrix Phase from the Phase list select FCC_A1.  
4. Under Precipitate Phase from the Phase list select AL3SC.  
5. Under Calculation Type, select Isothermal, which means that the same temperature is 

maintained throughout the calculation.  
6. Enter 350 as the Temperature and select Celsius.  
7. Enter 1.0E9 as the Simulation time and select Seconds. 

 

Our first calculation is set, so we will configure the plot.  
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Configuring the Plot 

1. In the Project window, right-click Plot Renderer 1 and select Rename. Name the plot Mean 
radius then press enter or click OK. 

2. Under Y-axes, change the units to nm (nanometres) and from the Axis type list select 
Logarithmic 10.  

 

The plot is now set, but we will set up another calculation and link it to the same plot renderer 
before we run the simulation.  

Setting up the Precipitation Calculation with Cuboid Morphology 

1. In the Project window, right-click the Sphere node and select Clone.  
2. Right-click the new calculator node and select Rename.  
3. Name the node Cuboid and click OK.  
4. On the Configuration window to the right of Matrix Phase click Show Details.  
5. From the Elastic Properties list select Cubic. The program automatically suggests a good set 

of default values, so we will leave them as they are.  

 

6. To the right of Precipitate Phase, click Show Details.  
7. From the Morphology list select Cuboid.  
8. From the Transformation strain list select Calculate from molar volume. 
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The second calculation is now set up, so we will link it to the Plot Renderer node.  

Linking the Plot to the Calculation with Cuboid Morphology 

1. In the Project window, right-click the Mean radius node and select Add Predecessor 
>Cuboid.  

2. Notice that in the Configuration window there are two tabs associated with this plot, one for 
Sphere and one for Cuboid. We already configured the Sphere settings, so we just need to 
set up the Cuboid tab.  

3. Click the Cuboid tab. 
4. Under Y-axes, change the unit to nm (nanometers) and from the Axis type list select 

Logarithmic 10.  
5. Our calculation is now ready, so right-click the Mean radius node and select Perform Now.  
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INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATIONS 

 

In this plot, the blue line represents the sphere calculation and the red line represents the cuboid 
calculation. You can see that, in this instance, they are almost identical.  

By ‘radius for non-spherical particles’ we mean the radius of equivalent spheres with the same 
volume. 

If you run the example file that is included in your software, the plot also contains an experimental 
file, which you can see closely matches the calculations. 

PLOTTING ADDITIONAL VARIABLES 

We will now use the same calculation to set up additional plots using the many plot variables that are 
available in the program. The examples below include two Y-axes each.  

Plotting Mean Radius and Cuboid Factor 

This plot will have two Y-axes: Mean radius and Cuboid factor.  

1. Right.click the Cuboid node and add a Plot Renderer.  
2. Right-click the new node and rename it Mean radius and Cuboid factor.  
3. Under Y-axes click the green plus sign to add another axis.  
4. Leave the first axis variable as Mean radius, but change the units to nm (nanometers) and set 

the axis type to Logarithmic 10.  
5. Set the second Axis variable to Mean cubic factor.  
6. Click to clear the Automatic Scaling check box. In the fields, enter the Limits from 1 to 1.41 

and the step to 0.1.  

In this plot, the blue 
line represents the 
sphere calculation 
and the red line 
represents the cuboid 
calculation. You can 
see that, in this 
instance, they are 
almost identical.  
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7. The plot is now set, so right-click the Mean radius and Cuboid factor node and select 
Perform Now.  

 

Interpreting the Results of Mean Radius and Cuboid Factor 

 

The blue line represents the evolution of the average radius of the cubic particles as a function of 
time. Again, for non-spherical precipitates this means the radius of equivalent spheres with the same 
volume.  

In this plot, the blue 
line represents the 
evolution of the 
average radius of the 
cubic particles as a 
function of time. The 
red line shows the 
average cubic factor 
as a function of time. 
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The red line shows the average cubic factor as a function of time. A value of one represents a 
spherical shape. A square root of two represents a cubic shape.  

The evolution of the shape when the particles grows is determined by competition between 
interfacial energy and elastic strain energy. In general the shape is close to spherical at small particle 
sizes because the interfacial energy term dominates.  

At large sizes the elastic energy dominates and it is therefore more favourable with a non-spherical 
shape.  We can see that the particles get a more cubic form at later times when they grow to larger 
sizes.  

Plotting Particle Size and Cubic Factor Distribution 

This final plot will show the particle size and cubic factor distribution at the end of the simulation.  

This plot will also have two Y-axes, so we will clone the previous plot. 
1. Right-click the Mean radius and Cuboid factor node and select Clone. 
2. Right-click the new node and rename it PSD and Cuboid factor.  
3. Under the Y-axes, select Size Distribution as the first Axis variable.  
4. Change the Axis type to Linear.  
5. Set the second Y-axis to Cubic factor distribution and enter a Time of 1e9 Seconds.  
6. Click to clear the Automatic Scaling check box. Enter the Limits from 1 to 1.45 and the step 

to 0.1.  
7. Under Size X-axis, change the unit to nm (nanometers).  
8. Click Perform at the bottom centre of the Configuration window. 
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Interpreting the Results of Particle Size Distribution and Cuboid Factor 

 

The blue curve, which shows the particle size distribution, is close to the regular LSW size distribution 
that we would have expected for spherical particles.  

The cubic factor distribution shows that the smallest particles are closer to spherical and that the 
larger ones get more and more cubic. 

References 

1. Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates 
in Al(Sc) Alloys.” Acta Materialia 49 (11): 1909–19. 

2. Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.” 
Materials Science & Engineering, A: Structural Materials: Properties, Microstructure and 
Processing 318 (1–2): 144–54. 

In this plot, the blue 
curve shows the 
particle size 
distribution and the 
red line shows the 
cubic factor 
distribution. 
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P_10: Initial Particle Size Distribution of Fe-Cr-C
This example demonstrates the effect of initial particle size distribution of the precipitate
phases on the overall precipitation kinetics. It uses two Precipitation Calculators to simulate
and compare carbide precipitations from a ferritic BCC_A2 matrix in a Fe-0.1C-12Cr alloy.
Three carbides, CEMENTITE, M23C6 and M7C3, are included in the calculations for
competitive precipitations, and the precipitation kinetics are compared with or without
initial particle size distribution.

The example illustrates the use of the particle size distribution setting. You can import data
from a spreadsheet or text file (.xls, .xlsx, .csv or .txt formats are acceptable). The
Preexisting Particle Size Distribution window shown below, provides a graphical
representation of the radius versus corresponding frequencies.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_10_Precipitation_Initial_PSD_FeCrC.tcu

EXAMPLE SETTINGS
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System (System Definer)

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C, Cr

Conditions (Precipitation Calculator)

Composition Fe-0.1C-12Cr Mass percent

Matrix phase
BCC_A2

All other defaults are kept.

Precipitate phases CEMENTITE, M23C6 and M7C3

Precipitate Phase Data Parameters (Precipitation Calculator)

Nucleation sites Grain boundaries (all calculations): Calculated from the matrix settings with a
wetting angle of 90°

Interfacial energy

User-defined function f(r,T) (all calculations):

l CEMENTITE: 0.167 J/m2

l M23C6 0.252 J/m2

l M7C3 0.282 J/m2

Preexisting size
distribution (click Show
details to display this
setting)

For the Precipitation Calculator including particle size distribution, and for all
precipitate phases, this check box is selected.

For each precipitate phase (CEMENTITE, M23C6 and M7C3), click Edit particle
size distribution to make changes to the parameters. A window opens with a
graphical representation of the radius vs number density.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

Temperature 1053 K

Simulation time 400 000 seconds

PLOT RESULTS
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Volume Fraction with Initial Particle Size Distribution
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Volume Fraction with No Initial Particle Size Distribution

P_11: Interfacial Energy Function
In some cases, interfacial energy may be a function of temperature and/or particle radius.
This example uses four Precipitation Calculators at four temperature points in 30 K
increments: 673 K, 703 K, 733 K, and 763 K. It is an isothermal calculation to examine the
mean radius of an Al-0.12Sc system. It uses an FCC_A1 matrix phase and AL3SC precipitate
phase with bulk nucleation sites and user-defined interfacial energy function. The user
defined interfacial energy function uses an error function to set a smooth transition of the
interfacial energy from 0.065 J/m2 to 0.085 J/m2 for particle radii below and above 1e-8m
and 5e-8m, respectively.

A dataset based on Iwamura and Miura (1. ) data is compared with the calculated results.

PROJECT FILE INFORMATION

1. Iwamura, S, and Y Miura. 2004. “Loss in Coherency and Coarsening Behavior of Al3Sc Precipitates.” Acta Materialia 52
(3): 591–600.
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l Folder: Precipitation Module - TC-PRISMA

l File name: P_11_Interfacial_energy_function.tcu

EXAMPLE SETTINGS

System (System Definer)

Database package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Conditions (Precipitation Calculator)

Composition Al-0.12Sc Mole percent

Matrix phase
FCC_A1

All other defaults are kept.

Precipitate phase

AL3SC

Nucleation sites (all calculations): Bulk (6.025E28 m-3)

Interfacial energy (all calculations): User-defined function f(r,T): 0.075+0.011*erf
((r-3e-8)/1e-8 J/m2)

Calculation Type (Precipitation Calculator)

Calculation type Isothermal (all calculations)

Temperature Four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K.

Simulation time 1 000 000 seconds (all calculations)

Datasets (Experimental File Reader)

Wamura 2004
(Dataset 1)

Data set included with this example and imported to one Experimental File
Reader.

PLOT RESULTS
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Mean Radius

P_12: Comparing Growth Rate Models for an Al-Zr
System
This example compares the Simplified, General and Advanced growth rate models for an
Al-Zr system. The resulting plot compares the mean radius of the spheres for each AL3ZR_
D023 precipitate phase calculated for each type of growth rate model.

The example takes several minutes to run.

All models treat a spherical particle (precipitate) of stoichiometric composition or with
negligible atomic diffusivity. Local equilibrium at the precipitate-matrix interface is
assumed.

When you use the Advancedmodel, the velocity of a moving phase interface and the
operating tie-line are solved together from flux-balance equations. This model can treat
both high supersaturation and cross diffusion rigorously. It can also capture the transition
between NPLE (non-partitioning local equilibrium) and PLE (partitioning local equilibrium)
without any ad hoc treatment.
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The Simplifiedmodel is based on the quasi-steady state diffusion approximation, and
estimates solute partitioning with matrix composition and nuclei composition instead of
time-consuming stepwise tie-line calculations. It also neglects cross diffusion for simplicity.

The General model can be considered the same theoretical approximation as, but an
improvement over, the Simplifiedmodel, with cross-diffusion terms taken into account, as
well as adjustment of Gibbs-Thomson effect and effective diffusivity implemented.

A dataset based on Knipling et al. (1. ) data is compared with the calculated results.

PROJECT FILE INFORMATION

l Folder: Precipitation Module - TC-PRISMA

l File name: P_12_Precipitation_Al-Zr_GrowthRateModel_comparison.tcu

EXAMPLE SETTINGS

System (System Definer)

Database
package Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements Al, Zr

Conditions (Precipitation Calculator)

Composition Al-0.2Zr Mole percent

Matrix phase
FCC_A1

All other defaults are kept.

Precipitate
phase

AL3ZR_D023

Click Show details to select the Growth rate model (Simplified, Advanced and
General). All other defaults are kept.

Calculation Type (Precipitation Calculator)

Calculation type Isothermal

1. Knipling, Keith E., David C. Dunand, and David N. Seidman. 2008. “Precipitation Evolution in Al–Zr and Al–Zr–Ti Alloys
during Isothermal Aging at 375–425°C.” Acta Materialia 56 (1): 114–27. doi:10.1016/j.actamat.2007.09.004.
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Temperature 425 Celsius

Simulation time 400 hours

Datasets (Experimental File Reader)

2008 Knipling Data set included with this example and imported to one Experimental File Reader.

PLOT RESULTS

Mean Radius
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